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Hydrogel with ROS scavenging effect encapsulates
BR@Zn-BTB nanoparticles for accelerating diabetic
mice wound healing via multimodal therapy

Jing-Jing Hu,1,4 Xue-Zhao Yu,1,4 Shu-Qin Zhang,1 Yu-Xuan Zhang,2 Xiao-Lin Chen,1 Zhu-Jun Long,1

Hua-Zhong Hu,1 Deng-Hui Xie,1 Wen-Hua Zhang,3 Jin-Xiang Chen,2,* and Qun Zhang1,5,*

SUMMARY

The strategies for eliminating excess reactive oxygen species (ROS) or suppress-
ing inflammatory responses on the wound bed have proven effective for diabetic
wound healing. In this work, a zinc-based nanoscale metal-organic framework
(NMOF) functions as a carrier to deliver natural product berberine (BR) to form
BR@Zn-BTB nanoparticles, which was, in turn, further encapsulated by hydrogel
with ROS scavenging ability to yield a composite system of BR@Zn-BTB/Gel (de-
noted as BZ-Gel). The results show that BZ-Gel exhibited the controlled release of
Zn2+ and BR in simulated physiological media to efficiently eliminated ROS and in-
hibited inflammation and resulted in a promising antibacterial effect. In vivo
experiments further proved that BZ-Gel significantly inhibited the inflammatory
response and enhanced collagen deposition, as well as to re-epithelialize the
skin wound to ultimately promote wound healing in diabetic mice. Our results
indicate that the ROS-responsive hydrogel coupled with BR@Zn-BTB synergisti-
cally promotes diabetic wound healing.

INTRODUCTION

Diabetic chronic wounds are one of the most common and serious complications of diabetic patients and

have become a growing problemworldwide.1 Due to the limited regenerative capacity after injury, diabetic

wounds, especially diabetic foot ulcers (DFU) would be deteriorated and seriously threatened the health

and life of patients, resulting in the 5-year survival rate being only 29�50%.2,3 The increased DFU-related

amputations and medical expenditures have become a heavy burden on the public health system and

patients.4 At present, hyperbaric oxygen therapy and skin replacement therapy are the main treatment

methods for DFU-related diabetic wounds.5 But there are some disadvantages, such as poor therapeutic

efficacy and high treatment cost. Although some treatments are effective for selective patients, diabetic

wounds are in general difficult to cure.6

Diabetic wounds are chronic and incurable mainly due to a variety of cytokine metabolism disorders and

impaired procedural repair.7,8 At present, its detailed pathogenesis is not yet clear but is found to relate

to vascular disease, neuropathy, pathogen infection, oxidative stress, chronic inflammation, extracellular

matrix (ECM) abnormalities, etc.9 Among the physiological and pathological factors that cause this symp-

tom, the continuous inflammatory response and excessive reactive oxygen species (ROS) in the wounds are

two key reasons.10,11 Due to impaired glucose metabolism, excessive ROS and inflammatory factors pro-

duced by macrophages cannot be removed normally in the acute inflammation stage of diabetes (or the

mid-stage of wound healing), leading to cytotoxicity and skin tissue damage.12 In addition, excessive

ROS and chronic inflammation also up-regulate the expression of the zinc-dependent matrix

metalloproteinases-9 (MMP-9) by activating the nuclear factor-kappa B (NF-kB) pathway,13 which disrupt

the balance of ECM deposition and remodeling and prevent epithelial closure.

Excessive activation of MMP-9 can lead to the destruction of local ECM. Without the scaffold provided by

ECM, cell migration will be impaired and the epithelial closure of the wound will be blocked. This increases

the risk of infection.14,15 Once bacterial infection commenced, it aggravates the inflammatory response and

duration, which, in turn, further promotes the expression of MMP-9 and results in a vicious circle leading to

prolonged wound healing.16 Thus, the balance betweenMMP-9 andmetalloproteinase inhibitor-1 (TIMP-1)
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is a key determinant of the accumulation and remodeling of collagen and non-collagen ECM components

in the later stage of wound healing.17

Contemporary efforts have focused on the mechanism of ROS elimination, angiogenesis promotion,

local anti-inflammatory, and anti-infection using a large number of innovative composite materials,

such as nanoparticles, electrospun fibers, and composite hydrogels. These genuinely designed materials

also showed great potential in accelerating wound healing. For example, the constructed inorganic

nano-enzymes could efficiently remove excess ROS produced by wounds.18 The angiogenesis-promoting

drugs delivered by a carrier could promote the formation of blood vessels in diabetic wounds.19 The

super-porous hydrogel dressing with silver-ethylene interaction could inhibit bacterial infection and

promote wound healing.20 Nevertheless, for the complicated microenvironment of diabetic wounds,

treatment regimens based on a single mechanism often fail to provide an ideal therapeutic outcome,

and multifunctional wound care strategies are urgently needed to deal with difficult-to-heal diabetic

wounds.

Berberine (BR) is a naturally occurring isoquinoline alkaloid with multiple functions such as anti-oxidation,

antibacterial, and anti-inflammatory. It has attracted widespread attention in the treatment of various dis-

eases.21 Previous studies have shown that BR can reduce the expression of pro-inflammatory cytokines

(such as IL-6, TNF-a, etc.). Recently, a series of studies have shown that BR has a beneficial effect on the

treatment of wound healing and endothelial injury.22 In addition, BR is a broad-spectrum plant antibiotic

with excellent antibacterial activity and has the potential to act as an antibacterial therapeutic agent.23

However, due to its relatively poor solubility in plasma, low biological stability, and limited bioavailability,

BR has not been widely adopted clinically.24 Therefore, maintaining a safe concentration of BR in local

wounds and improving its bioavailability are important prerequisites for the use of BR to treat diabetic

wounds.

Nanoscale metal-organic frameworks (NMOFs) are considered ideal drug carriers for potential biomedical

applications due to their high porosity and the biological utility of both ligands and central ions.25–27 In

particular, some NMOFs can operate synergistically with loaded drugs, thereby greatly improving the

treatment efficacy.28 For example, PCN-224 and HKUST-1 have photothermal and photoelectronic conver-

sion capabilities, which showed great potential in eliminating bacterial infections in wounds.29–31

The central metal ions can be released during the degradation of NMOFs.32 In this sense, choosing a

suitable metal ion for an NMOF can increase the drug loading rate while creating a favorable ionic

microenvironment for promoting wound healing. Previous studies have shown that the presence of Zn2+

can significantly increase the activity of Cu, Zn-superoxide dismutase (CuZn SOD) to promote skin cells

to fight against ROS,33 as well as to inhibit bacterial reproduction by destroying the stability of bacterial

capsules.34

Polyvinyl alcohol (PVA)-based hydrogel has become an ideal wound dressing due to its good hydrophilic-

ity, biocompatibility, and adjustable mechanical properties.35 Taking into account the excessive ROS level

in diabetic wounds, the ROS-responsive linking agent N,N,N0,N0-tetramethyl-1,3-propanediamine,

4-(bromomethyl) phenylboronic acid (TPA) and PVA was used to cross-link and polymerize to prepare a

composite hydrogel TPA-PVA, which showed antibacterial and ROS scavenging properties due to the

introduction of quaternary ammonium and phenyl borate functionalities.36,37 Studies have shown that

composite dressings prepared by encapsulating drugs or nanomaterials with hydrogels lead to the

improvement of the curative effect while avoiding adverse inflammatory reactions caused by particles.

We expect that a sustained release of Zn2+ and BR from the composite hydrogel dressing and the ROS-

responsive disintegration of the scaffold will jointly build a favorable microenvironment for promoting

diabetic wound healing.

Herein, the assembly of carboxylic acid ligand 1,3,5-tris(4-carboxyphenyl) benzene (H3BTB) and Zn2+

afforded NMOF Zn-BTB as a drug carrier for BR encapsulation. As far as we are aware, there are no previous

reports on the use of Zn-BTB NMOF as the drug carrier presumably due to the general water sensitivity of

Zn-based MOFs. The BR-loaded Zn-BTB is then embedded in the hydrogel scaffold of TPA-PVA to obtain

the composite BR@Zn-BTB/Gel (abbreviated as BZ-Gel). The hydrogel composite dressing removes ROS
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from wounds and slowly degrades, accompanied by the release of Zn2+ and BR. With the sustained release,

the safety and stability of BR are guaranteed.

Critically, the prepared stent has excellent anti-inflammatory, antibacterial, and antioxidant properties to

synergistically promote diabetic wound healing. This study reveals the promising potential of ROS scav-

enging hydrogel scaffolds in combination with BR@Zn-BTB NMOF for the treatment of diabetic wounds

in a multi-purposeful manner.

RESULTS AND DISCUSSION

Preparation and characterization of BR@Zn-BTB particles and BZ-Gel hydrogel scaffold

In this work, the BR@Zn-BTB nanoparticles were prepared by a facile one-pot synthetic method, the specific

condition exploration process was shown in Figure S1. The drug loading efficiency of BR of about 35% was

detected by the standard curvemethod as shown in Figure S2. As indicated by SEM (Figures 1A and 1B), the

as-synthesized Zn-BTB appeared amorphous while BR@Zn-BTB presented as a columnar shape with clear

and neat edges. The difference in the morphology of the two nanoparticles may be due to the introduction

of BR which changed the coordination environment of metal ions and ligands. It was reported that the

MOFs constructed by the same metal ion and ligand has morphology change due to slight changes in

the synthetic conditions.38 As shown in Figure 1C, the average particle sizes of the prepared Zn-BTB and

BR@Zn-BTB were approximately 150 G 0.37 nm and 250 G 0.52 nm, respectively, which were consistent

with their SEM results. As shown in the PXRD spectra (Figure 1D), the prepared Zn-BTB and BR@Zn-BTB

had characteristic diffraction peaks at 2q angles of 6.24�, 7.58�, and 11.2�, indicating that BR@Zn-BTBmain-

tains the Zn-BTB structure with high crystallinity. The slight change in the diffraction pattern of the BR@Zn-

BTB should be attributed to the BR molecules retained in the Zn-BTB pores.39 The IR spectrum analysis was

shown in Figure 1E, two intense bands at 1544 cm�1 and 1404 cm�1 were observed in Zn-BTB, which were

assigned to the asymmetric and symmetric stretching vibrations of vC=O of carboxylate groups. The peak

Figure 1. Characterization of Zn-BTB and BR@Zn-BTB particles

(A and B) The SEM images of (A) Zn-BTB and (B) BR@Zn-BTB.

(C) The particle size distribution of Zn-BTB and BR@Zn-BTB by DLS.

(D) The PXRD spectra of the BR, simulated Zn-BTB, experimental Zn-BTB, and BR@Zn-BTB.

(E) The FT-IR spectra of BR, Zn-BTB, and BR@Zn-BTB.

(F) The UV-Vis spectra of the BR, Zn-BTB, and BR@Zn-BTB.
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that appeared at 2844 cm�1 revealed the existence of a -OMe group and thus the presence of BR. Both the

absorption peaks of carboxylate in Zn-BTB and -OMe group in BR were retained in the BR@Zn-BTB spec-

trum. The UV-Vis analysis further confirmed that BR was successfully loaded into Zn-BTB (Figure 1F). The

characteristic absorption peak of Zn-BTB was observed at 271 nm, and the strong absorption band of

BR appeared at 346 nm. These two characteristic peaks were also inherited in the BR@Zn-BTB. These re-

sults collectively indicate that BR@Zn-BTB contains both BR and Zn-BTB.

As water-based soft material, the hydrogel can absorb wound exudate to prevent the wound from drying

out and isolate the wound from the environment. It is an ideal choice for promoting wound healing. In pre-

vious studies, hydrogels were used as carriers for sustained drug release without other notable functions.

Since diabetic wounds are generally in a state of excessive oxidative stress, a hydrogel with the function of

ROS scavenging was synthesized as a nanoparticle carrier in this work. First, N,N,N0,N0-tetramethyl-1,3-pro-

panediamine and 4-(bromomethyl)phenylboronic acid are used to synthesize ROS-responsive linker TPA,

and the structure of TPA was determined by 1H NMR (Figure S3). The ROS-responsive hydrogel crosslinked

quickly by simply mixing PVA and TPA through the reactions between phenylboronic acid in TPA and

alcohol hydroxyl groups in PVA. As shown in Figure 2A, TPA and PVA were liquid, and when they were

mixed, a solid colloid with a certain viscosity is formed. Subsequently, the ROS-responsive degradation

behavior of hydrogel was evaluated in PBS with the introduction of hydrogen peroxide (H2O2). It was

observed from Figure 2B that the hydrogel degraded within 2 h in PBS containing H2O2. In contrast, the

hydrogel remained stable in PBS in the absence of H2O2, indicating that the hydrogel responds to ROS

causing its degradation. Meanwhile, the ROS-scavenging ability of the hydrogel was studied using the

HRP-TMB method. HRP could catalyze the decomposition of H2O2 to generate hydroxyl radicals ($OH).

These $OH then reacted with TMB to produce a blue azo compound, which has UV-Vis absorption peaks

at 650 nm.40 As shown in Figure 2C, the peak of the characteristic absorption peaks at 650 nm gradually

decreased within 2 h, indicating that the concentration of residual H2O2 in the solution was decreasing.

Also, the color of the solution gradually faded, indicating that this hydrogel could gradually quench the

generated ROS. After the determination of the ROS-scavenging ability of the hydrogel, the as-synthesized

BR@Zn-BTB was evenly loaded, and the state of the composite BZ-Gel could be observed in Figure 2D. It

can be seen that BZ-Gel has good adhesion and tensile properties. The internal structure was further

observed by SEM. As shown in Figure 2E, the pure hydrogel had relatively uniform pores with a pore

size of about 4 mm. The composite hydrogels Z-Gel and BZ-Gel loaded with nanoparticles had significantly

larger pores than pure hydrogels, with the BZ-Gel having the largest pore size of around 8 mm. It should be

noted that macro-porous hydrogels facilitated cell proliferation and migration compared to non-macro-

porous hydrogels.41

Cumulative release of BR and Zn2+ in BR@Zn-BTB and BZ-Gel hydrogel scaffold

BR@Zn-BTB was placed in PBS at pH values of 6.5, 7.0, 7.4, and 8.0 to evaluate its release characteristics at

different pH.42 As shown in Figure 3A, as the pH value increases, the release rate of BR from BR@Zn-BTB

gradually increases. Specifically, the release rate of BR from BR@Zn-BTB at 36 h is close to 80% at pH 8.0,

60% at pH 7.4, and 40% at both pH 7.0 and 6.5. At the same time, wemeasured the release rate of Zn2+ from

BZ-Gel at different pH (Figure S4). The supplement also proves that the release of Zn2+ is faster at higher

pH. Since the surface of normal skin is usually weakly acidic with a pH value in-between 4�6. In chronic and

infected wounds, the pH changes to alkaline, usually in-between 7.5�8.9.43 Therefore, it can be inferred

that BR@Zn-BTB is suitable for the treatment of malignant diabetic foot wounds.

The release behaviors of BR and Zn2+ in BZ-Gel were compared and evaluated in a release medium of phys-

iological pH 7.4. As shown in Figure 3B, the BR released from BZ-Gel was sustained and significantly

delayed within 36 h as compared to BR@Zn-BTB. It is closely related to the instability of Zn-BTB directly

exposed to PBS. Most importantly, the release time of BR in BZ-Gel can reach 100 h and above, and the

release rate is relatively slow, indicating that the slow disintegration of the hydrogel ensures the sustained

release of the drug to avoid the toxicity of BR caused by burst release. As shown in Figure 3C, the Zn2+

released from the BZ-Gel is also significantly prolonged (only 19.8% Zn2+ in the first 36 h) compared with

BR@Zn-BTB (approximately 38.9% within 36 h). In the subsequent release process, the release rate remains

stable and slow, which may play an important role in the wound healing process. The above results showed

that the hydrogel further released BR and zinc ions slowly. The above results indicated that the release of

BR and Zn2+ in the hydrogel was further sustained.
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In vitro antibacterial activity of BZ-Gel hydrogel scaffold

The inhibitory effect of BZ-Gel on Staphylococcus aureus, Staphylococcus epidermidis, and Escherichia

coli was measured by the disc diffusion method.20 As shown in Figure 4A, for S. aureus, the Gel, Z-Gel,

B-Gel, and BZ-Gel groups all showed inhibition zones, and the inhibition zones in the BZ-Gel group

were larger than other groups. For S. epidermidis, it was observed that the bacteriostatic zone around

BZ-Gel was greater than that of Z-Gel and B-Gel groups, while the zone of inhibition in the pure Gel group

was not obvious. In contrast, for E. coli, the inhibition zones in Gel, Z-Gel, B-Gel, and BZ-Gel groups had no

obvious difference. The diameter of the inhibition zone was shown in Figure 4B, for gram-positive bacteria

Figure 2. The synthesis and characteristics of hydrogels

(A) Photographs of the solution to hydrogel transition by mixing PVA solution and TPA solution.

(B) Photographs of the hydrogel degradation in H2O2.

(C) The UV-Vis spectra of TMB + H2O2 remaining (Initial concentration of H2O2: 100 mM).

(D) Photographs of the adhesion behavior of BZ-Gel.

(E) Representative SEM images of the Gel (E1), Z-Gel (E2), and BZ-Gel (E3) (scar bar: 30 mm).
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(S. aureus and S. epidermidis), the inhibition zone diameters of the Z-Gel and B-Gel groups were equiva-

lent, both at 0.7–0.9 cm, the BZ-Gel group had the largest zone diameter, which was 1.12 cm and 1.25 cm,

respectively. For E. coli. strains, the diameter of the inhibition zone of Gel, Z-Gel, B-Gel, and BZ-Gel groups

were about 1.0 cm. The above results proved that Gel had an inhibitory effect on S. aureus and E. coli but

not on S. epidermidis. The quaternary ammonium salt produced during the degradation of pure Gel

endows its antibacterial effect. Therefore, by loading Zn-BTB and BR components, the as-prepared com-

posite hydrogel was endowed with an expanded antibacterial spectrum and enhanced antibacterial

activity.

The pro-proliferative and pro-migratory effects of BZ-Gel hydrogel scaffold

The CCK-8 method was used to evaluate the biocompatibility of nanoparticles to human skin fibroblasts

(HSF) and HaCaT. As shown in Figures 5A and 5B, when the concentration of BTB ligand was increased

to 80 mg/mL, the cell viability of HSF and HaCaT was still close to 100%, indicating that H3BTB possessed

favorable biocompatibility. When the concentration of Zn-BTB reached 70 mg/mL, the cell viability of the

two cells was still greater than 80%. It could be speculated that part of the cell toxicity was caused by

the continuous accumulation of Zn2+ released by the slow disintegration of Zn-BTB in the culture medium.

In contrast, when the concentration of BR reached 20 mg/mL, the cell viability of HSF and HaCaT were less

than 60% and 80%, respectively, and they had obvious cytotoxicity against both cells. When the concentra-

tion of BR@Zn-BTB reached 60 mg/mL (with the corresponding BR concentration greater than 20 mg/mL),

the viability of the cells remained above 80%. It can be inferred that by loading BR on Zn-BTB, the sudden

release of BR was effectively controlled, which was beneficial to reducing the contact toxicity of BR and

increasing the bioavailability of BR. The concentration of Zn-BTB and BR@Zn-BTB was adjusted to

40 mg/mL, consistent with the concentration of nanoparticles loaded in the BZ-Gel hydrogel, and these ma-

terials were used for subsequent studies.

Re-epithelialization is a key process of wound healing and requires a new epithelial surface, in addition to

proper migration and proliferation of fibroblasts and keratinocytes around the wound.44 CCK-8 assay was

used to detect the long-term cytotoxicity and pro-proliferative of Zn-BTB and BR@Zn-BTB in HSF cell and

HaCaT cell at safe concentrations (40 mg/mL). As shown in Figures 5E and 5F, for the two types of cells, the

optical density (OD) values showed no significant difference for Zn-BTB, BR@Zn-BTB, and control groups

on day 1. On day 2, for HSF cells, there was no significant difference in the OD values among the three

groups. However, for HaCaT cells, the OD values of the BR@Zn-BTB group were significantly higher

than that of the other groups. On day 3, for both HSF and HaCaT cells, the OD values of the BR@Zn-

BTB group were significantly higher than that of the control and Zn-BTB groups.

To verify the biocompatibility of Gel, Z-Gel, and BZ-Gel, a live-dead staining method was used. As shown in

Figures 5C and 5D, for both HaCaT and HSF cells, there were no significant differences in the numbers

among the four groups on days 1 and 2. Notably, on day 3, the number of HaCaT and HSF cells was

more than those of the control for the Gel, Z-Gel, and BZ-Gel groups. These results show that Gel,

Z-Gel, and BZ-Gel exhibit good biocompatibility. In the healing process, multiple cells are required to

Figure 3. The slow-release characteristics of BZ-Gel

(A) BR released from BR@Zn-BTB in PBS with different pH values.

(B) BR released from BR@Zn-BTB and BZ-Gel at physiological pH (pH = 7.4).

(C) Zn2+ released from BR@Zn-BTB and BZ-Gel at physiological pH (pH = 7.4).
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migrate to the wound site to participate in wound healing. Here, the scratch assay was used to evaluate the

effects of the BZ-Gel hydrogel scaffold on pro-migration under a high-glucose environment (13.5 g/L).45

For HSF cells (Figure 5G), the scratch distance in the BZ-Gel group was the smallest, then followed by

Z-Gel after 48 h. There were no obvious differences in the scratch distance between the control and Gel

groups. For HaCaT cells (Figure 5H), the scratch distance in the BZ-Gel group was smaller than in the

control, Gel, and Z-Gel groups and there was no difference in the latter three groups. The results showed

that Z-Gel promoted the migration of HSF, but it did not promote the proliferation of HaCaT. Compared

with the Z-Gel group, the BZ-Gel hydrogel scaffold significantly promoted the migration of HSF and HaCaT

cells. BZ-Gel hydrogel had good compatibility with skin cells and the ability to promote skin cell prolifer-

ation and migration, and have great potential in promoting diabetic skin wound healing. In the BZ-Gel

group, BR and Zn2+ released by BZ-Gel can synergistically promote cell proliferation and migration.

In vitro antioxidant and anti-inflammatory effects, and the influence on MMP-9 gene

expression of BZ-Gel hydrogel scaffold

Due to the defense mechanism, the wound site of diabetic patients may produce excessive ROS.11 Exces-

sive production of ROS or continuous oxidative stress can lead to cell necrosis, local acute tissue damage,

or chronic inflammation.46 To tackle these obstacles, we synthesized the BZ-Gel with the ROS scavenging

effect. In this study, DCFH-DA was used to verify the antioxidant capacity of BZ-Gel. As shown in Figure 6A

and fluorescence readings (Figure S5), the green fluorescence of the BZ-Gel group was the weakest among

Z-Gel, Gel, and control groups, indicating that the BZ-Gel hydrogel scaffold has a good ability of scav-

enging ROS.

Inflammation is a normal part of the wound healing process. However, in chronic wounds, pro-inflammatory

macrophages persist without changing to an anti-inflammatory phenotype, which severely inhibits tissue

repair.47 LPS is a component of the outer wall of Gram-negative bacteria, composed of lipids and polysac-

charides. The cellular inflammatory response stimulated by LPS is believed to be caused by the classic NF-

kB pathway.48 In this study, LPS was used to stimulate RAW264.7, and qRT-PCR was used to detect the

expression levels of inflammatory factors and evaluate the anti-inflammatory ability of BZ-Gel in which

the loaded BR and Zn2+ can play an anti-inflammatory effect. As shown in Figures 6B–6D, the expression

of IL-1b, IL-6, and TNF-a in the group without LPS stimulation was lower than in the group with LPS stim-

ulation. The results indicated that the stimulation of LPS successfully activated the inflammatory pathway.

There was no difference between the LPS-stimulated group and the Gel group. In the Z-Gel group only the

inflammatory factor IL-6 was decreased compared with the LPS-stimulated group. Compared with the LPS-

stimulated group, the expressions of inflammatory factors IL-1b, IL-6, and TNF-a in the BZ-Gel group were

significantly decreased. The results showed that Z-Gel can inhibit the expression of inflammatory factor

IL-6, and BZ-Gel can inhibit the expression of inflammatory factor IL-6, IL-1b, and TNF-a.

It is well-established that the over-expression of MMP-9 leads to a decrease in the ratio of TIMP-1/MMP-9,

which seriously hinders the healing of diabetic wounds.49,50 As shown in Figure S6, the expression of

MMP-9 in HaCaT cells in a high-glucose culture environment (13.5 g/L) is higher than that in a normal envi-

ronment. Herein, the influence of BZ-Gel on the expression of MMP-9 and TIMP-1 in HaCaT cells under a

high-glucose environment was analyzed by qRT-PCR. As shown in Figure 6E, the expression of MMP-9 in

Figure 4. The antimicrobial characteristics of BZ-Gel

(A) Disc diffusion studies of the Gel, Z-Gel, B-Gel, and BZ-Gel hydrogel against S. aureus, S. epidermidis, and E. coli.

(B) Quantitative analysis of the antibacterial activity in vitro.
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the BZ-Gel group was significantly lower than that of the control, Gel, and Z-Gel groups. There was no dif-

ference in the expression of TIMP-1 in each group (Figure 6F). However, as shown in Figure 6G, the ratio of

TIMP-1/MMP-9 was significantly different. The ratio of TIMP-1/MMP-9 for the BZ-Gel group is higher than in

other groups. The above results proved that BZ-Gel hydrogel can effectively inhibit the expression of

MMP-9 in diabetic wounds, increase the ratio of TIMP-1/MMP-9, and promote diabetic wound healing.

The BZ-Gel hydrogel scaffold accelerating diabetic wound healing in vivo

The effect of the BZ-Gel hydrogel scaffold on diabetic wound healing in vivo was investigated by using the

STZ-induced diabetic mice model. As shown in Figure 7A, the skin wounds of diabetic mice (4 = 10 mm)

gradually healed within the experimental time, and the healing rate of the BZ-Gel hydrogel scaffold was

significantly higher than those of the other groups. The simulation of the wound healing process (Figure 7B)

intuitively shows the changes in the wound area, where the blue area was the wound area on day 0, and the

purple area on day x (x = 5, 9, and 12). As shown in Figure 7C, the statistical data of wound healing showed

that, on day 5, there was no significant difference in the change of wound area of each component. On day

9, the skin wound healing area of the BZ-Gel group (75.2%) was significantly higher than that of the Z-Gel

group (69.5%), Gel group (67.5%), and control group (61.1%). On day 12, the skin wound healing rate of the

BZ-Gel group (93.3%) was significantly higher than that of the Z-Gel group (92.5%), Gel group (91.0%), and

control group (85.2%). The results above indicated that the BZ-Gel scaffold can effectively promote wounds

healing in diabetic mice.

The effect of BZ-Gel hydrogel scaffold suppressing inflammatory factors in diabetic wound

H&E histological staining was used to further evaluate the degree of wound healing. As shown in Figures 8A

and 8B, consistent with results observed in vitro, for the BZ-Gel group, the un-repaired part was shorter (red

arrow) than that of Z-Gel, Gel, and control at days 9 and 12. Compared with day 9, the skin tissue wound

Figure 5. The cell viability and proliferative activity of BZ-Gel

(A–F) Cell viability of (A) HSF and (B) HaCaT cells cultured with H3BTB, BR, Zn-BTB, and BR@Zn-BTB evaluated by CCK-8 assay. Cell viability of (C) HSF and (D)

HaCaT cells cultured with Gel, Z-Gel, and BZ-Gel. Proliferative activity of (E) HSF and (F) HaCaT cells cultured with Zn-BTB and BR@Zn-BTB evaluated by

CCK-8 assay on days 1, 2, and 3, respectively. Representative images of the scratch method of (G) HSF and (H) HaCaT cells after culturing with Gel, Z-Gel, and

BZ-Gel for 48 h.
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Figure 6. The effect of BZ-Gel on clearing ROS, inhibiting inflammation, and inhibiting MMP-9 expression

(A–G) (A) DCFH-DA staining of HSF cells cultured with H2O2 (100 mM) for 24 h with Gel, Z-Gel, and BZ-Gel and imaged by inverted fluorescence microscope.

The expression levels of (B) TNF-a, (C) IL-1b, and (D) IL-6 assessed by qRT-PCR analysis. The expression levels of (E) MMP-9, (F) TIMP-1, and (G) TIMP-1/MMP-

9 assessed by qRT-PCR analysis.

ll
OPEN ACCESS

iScience 26, 106775, June 16, 2023 9

iScience
Article



space on day 12 had certain shrinkage, and some skin appendages have grown. It could be seen from the

enlarged part that the cells in the control group are dense, with most of them featuring inflammatory cells,

while the BZ-Gel group had relatively few cells and accordingly fewer inflammatory cells. Moreover, as

shown in Figures 8C–8E, compared with the control group, the gene expression of TNF-a, IL-1b, and

IL-6 in the Gel, Z-Gel, and BZ-Gel groups was significantly down-regulated, especially for the BZ-Gel group.

By increasing the biocompatibility of materials, immune rejection and the production of inflammatory

factors can be reduced.51 In addition, several reports have shown that BR has anti-inflammatory effects

on different inflammatory diseases. The main mechanism is that BR can inhibit the activation of NLRP3 in-

flammasomes by inducing mitochondrial autophagy and reducing mitochondrial ROS, thereby inhibiting

TNF-a and IL-1b, and IL-6 gene expression.52 The above results indicate that BZ-Gel can inhibit wound

inflammation and promote wound healing.

The effect of BZ-Gel hydrogel scaffold on promoting collagen deposition and inhibiting the

expression of MMP-9

The deposition and remodeling of collagen are beneficial to enhance tissue tensile strength and promote

wound healing.53 Therefore, Masson’s trichrome staining test was performed to evaluate collagen

Figure 7. The effect of BZ-Gel on the diabetic mice wound healing

(A) The size change of back skin resection in diabetic mice at different periods.

(B) Simulation of wound bed closure trace in each group in vivo. The blue area represented the wound area on day 0 and the purple area represented the area

of the wound on day x (x = 5, 9, and 12).

(C) The wound area of the four groups statistically analyzed to show the healing effect.
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deposition in diabetic wounds. As shown in Figures 9A and 9B, on day 12, the BZ-Gel collagen blue staining

area is large with deep color, while that of the control group is small with light color. This indicates the

coverage of the collagen in the BZ-Gel group was higher. qRT-PCR was used to detect the expression of

MMP-9 in the skin tissue of mice to detect the effect of BZ-Gel hydrogel on MMP-9. As shown in

Figures 9C–9E, the expression of MMP-9 was decreased, and the expression of TIMP-1 was increased

and with the ratio of TIMP-1 to MMP-9 also higher than that of the control group. This is inconsistent

with the results of cell experiments, because the results were obtained under the condition that the inflam-

mation has been relieved. Long-term inflammation is one of the main reasons that hinder the healing of

diabetic wounds. Previous studies have shown that the expression of MMP-9 was very low under steady-

state conditions and could be activated by the over-expression of pro-inflammatory factors such as IL-6

and IL-1b.16 With the improvement of wound inflammation, the expression of MMP-9 will decrease, and

the expression of TIMP-1 will increase.54 Therefore, after the wound inflammation was improved, the

expression of MMP-9 and TIMP-1 on the wound will also progress in the direction of promoting wound

healing. Overall, the above results indicated that BZ-Gel hydrogel significantly accelerated wound healing

by promoting collagen deposition and inhibiting MMP-9 expression.

Conclusions

In this work, an ROS-responsive hydrogel encapsulating BR@Zn-BTB nanoparticles was developed to pro-

mote diabetic wound healing by eliminating ROS, inhibiting inflammatory factors, and the over-expression

Figure 8. The effect of BZ-Gel on anti-inflammatory in diabetic mice

(A) Histological evaluation of H&E staining for the newly grown epithelium in the control, Gel, Z-Gel, and BZ-Gel groups at days 9 and 12 (bar:500 mm, 50 mm).

(B) Quantitative analysis of inflammatory cells.

(C–E) The expression levels of (C) IL-1b, (D) TNF-a, and (E) IL-6 assessed by qRT-PCR on day 12.
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of MMP-9. The results showed that the Zn-based NMOF with BTB as the ligand has a high BR-loading ca-

pacity of about 350 mg/g and achieves a controlled release of BR and Zn2+. In vitro experiments show that

the composite hydrogel can eliminate ROS, and the released Zn2+ and BR could be anti-inflammatory and

inhibit the expression ofMMP-9 and promote skin cell proliferation andmigration. In addition, the compos-

ite hydrogel dressing showed the synergistic antibacterial effect of BR and Zn2+ in the antibacterial

experiment in vitro. The in vivo results further show that BZ-Gel could inhibit the inflammation of the

skin tissue of the diabetic wound enhance the deposition of collagen, and ultimately promote the healing

of the wound of diabetic mice. This study showed that the ROS-responsive hydrogel dressing encapsulated

with BR@Zn-BTB provides a new strategy for promoting diabetic wound healing.
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STAR+METHODS

KEY RESOURCES TABLE

REAGENT or RESOURCE SOURCE IDENTIFIER

Bacterial and virus strains

Staphylococcus aureus BNCC BNCC186067

Staphylococcus epidermidis BNCC BNCC185917

Escherichia coli BNCC BNCC336902

Chemicals, peptides, and recombinant proteins

ZnCl2 Macklin Z820755;

CAS: 7646-85-7

Berberin hydrochloride Macklin B875003;

CAS: 2086-83-1

H3BTB Macklin T833353-1g

CAS: 50446-44-1

Poly (vinyl alcohol) Macklin P914585;

CAS: 9002-89-5

Tetramethyl-1,3-diaminopropane Macklin N819128;

CAS: 110-95-2

4-(Bromomethyl)phenylboronic acid Macklin B803441;

CAS: 68162-47-0

Dimethylformamide Macklin N807505;

CAS: 25174

DCFH-DA Sigma-Aldrich D6883-50;

CAS: 4091-99-0

Streptozotocin Sigma-Aldrich S0130;

CAS:18883-66-4

fetal bovine serum Gibco A316802

Dulbecco’s modified eagle medium Gibco C11995500BT

Pancreatin Gibco 25200056

Trizol Life Technologies 15596026

TB Green� Premix Ex Taq� II TaKaRa RR820A

Critical commercial assays

CCK-8 Beyotime C0037

LIVE/DEAD� Cell Imaging Kit Beyotime C2015S

Hematoxylin and Eosin Staining Kit Solarbio G1120-100

Masson’s Trichrome Stain Kit Solarbio G1340

Experimental models: Cell lines

Human: HSF cells NEWGAINBIO CH1178-1

Human: HaCat cells NEWGAINBIO CH1031-1

mice: RAW264.7 NEWGAINBIO CM3034

Oligonucleotides

Primers for qRT-PCR of MMP-9 mRNA (Human):

(F)50GGACCCGAAGCGGACATTG;

(R)50 CGTCGTCGAAATGGGCATCT

TSINGKE None

(Continued on next page)

ll
OPEN ACCESS

16 iScience 26, 106775, June 16, 2023

iScience
Article



Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

Primers for qRT-PCR of TIMP-1 mRNA (Human):

(F)50 CTTGGTTCCCTGGCGTACTC;

(R)50 ACCTGATCCGTCCACAAACAG

TSINGKE None

Primers for qRT-PCR of actin mRNA (Human):

(F)50 GCCGGGACCTGACTGACTAC;

(R)50 TTCTCCTTAATGTCACGCACGAT

TSINGKE None

Primers for qRT-PCR of MMP-9 mRNA (Human):

(F)50 CATTCGCGTGGATAAGGAGT;

(R)50 TCACACGCCAGAAGAATTTG

TSINGKE None

Primers for qRT-PCR of TIMP-1 mRNA (Mouse):

(F)50 CGAGACCACCTTATACCAGCG;

(R)50 ATGACTGGGGTGTAGGCGTA

TSINGKE None

Primers for qRT-PCR of IL-6 mRNA (Mouse):

(F)50 GGAGCCCACCAAGAACGATA;

(R)50 ACCAGCATCAGTCCCAAGAA

TSINGKE None

Primers for qRT-PCR of TNF-a mRNA (Mouse):

(F)50 CTCATGCACCACCATCAAGG;

(R)50 ACCTGACCACTCTCCCTTTG

TSINGKE None

Primers for qRT-PCR of IL-1b mRNA (Mouse):

(F)50 ATGAAGGGCTGCTTCCAAAC;

(R)50 TCTCCACAGCCACAATGAGT

TSINGKE None

Primers for qRT-PCR of GAPDH mRNA (Mouse):

(F)50 GGGTCCCAGCTTAGGTTCAT;

(R)50 CCAATACGGCCAAATCCGTT

TSINGKE None

Software and algorithms

Image J NIH https://imagej.nih.gov/ij/download.html

Origin OriginLab https://www.originlab.com

GraphPad Prism GraphPad https://www.graphpad.com/

Other

Field-emission scanning electron microscopy, FE-SEM GeminiSEM sigma 500;

https://www.zeiss.com.tw/microscopy/

local-content/

Zeta-sizer Nano ZS, Malvern Zeta-sizer Nano ZS;

https://somf.engr.tamu.edu/zetasizer

Powder X-ray Diffraction, PXRD Rigaku D/MAX-2200;

https://www.rigaku.com/products/xrd

Fourier Transform infrared spectroscopy, FT-IR PerkinElmer Frontier FT-IR/NIR/FIR;

https://chem.washington.edu/instruments/

perkin-elmer-frontier-ftir

Nuclear Magnetic Resonance, NMR BRUKER AVANCE-III HD 400 MHz;

https://pharm.ucsf.edu/nmr/instruments/

bruker-400

Inductively Coupled Plasma Mass spectrometry, ICP-MS PerkinElmer Optima 7000 DV;

https://www.labx.com/product/perkinelmer-

optima-7000-dv

Ultraviolet–visible spectroscopy, UV-Vis Perkin Elmer LS55 UV-Vis spectrometer;

https://www.spectralabsci.com/

equipment/perkin.

ll
OPEN ACCESS

iScience 26, 106775, June 16, 2023 17

iScience
Article

https://imagej.nih.gov/ij/download.html
https://www.originlab.com
https://www.graphpad.com/
https://www.zeiss.com.tw/microscopy/local-content/
https://www.zeiss.com.tw/microscopy/local-content/
https://somf.engr.tamu.edu/zetasizer
https://www.rigaku.com/products/xrd
https://chem.washington.edu/instruments/perkin-elmer-frontier-ftir
https://chem.washington.edu/instruments/perkin-elmer-frontier-ftir
https://pharm.ucsf.edu/nmr/instruments/bruker-400
https://pharm.ucsf.edu/nmr/instruments/bruker-400
https://www.labx.com/product/perkinelmer-optima-7000-dv
https://www.labx.com/product/perkinelmer-optima-7000-dv
https://www.spectralabsci.com/equipment/perkin
https://www.spectralabsci.com/equipment/perkin


RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be fulfilled by

the lead contact, Qun Zhang (zq1979@smu.edu.cn).

Materials availability

This study did not generate new unique reagents.

Data and code availability

Data reported in this paper will be shared by the lead contact upon request.

This paper does not report original code.

Any additional information required to reanalyze the data reported in this paper is available from the lead

contact upon request.

EXPERIMENTAL MODEL AND SUBJECT DETAILS

Diabetic mice model

The experimental animals in this study were purchased from the Guangdong Provincial Animal Center, and

the animal experiments were approved by the Guangdong Provincial Animal Ethics Committee. The dia-

betic mice were induced by streptozotocin (STZ) according to previous reports.55 Briefly, male mice aged

6–8 weeks were intraperitoneally injected with STZ at a dose of 50 mg/kg for 5 consecutive days. 2 weeks

after STZ injection, the blood glucose value of the tail tip of the mice was measured, and the blood glucose

at the two random times was not less than 300 mg/dL (16.7 mmol/L).

Cell line culture

Human skin fibroblasts (HSF) and human immortalized keratinocytes (HaCaT) cells were cultured in DMEM

medium with the supplementation of 10% (v/v) FBS and 100 units/mL Penicillin/Streptomycin (GIBCO).

RAW264.7 cells were cultured in DMEM (GIBCO) medium with the supplementation of 20% (v/v) FBS.

The cells were cultured under 5% CO2 at 37
�C.

High-glucose environmental cell model

D-glucosewas added toDMENmedium toprepare a high-glucosemediumwith a concentration of 13.5 g/L,

and then filtered through a sterile microporous filter head (PES13x0.22). The cells were seeded in petri

dishes. After 12 h, remove the supernatant and add the prepared high-glucose medium.

Inflammatory cell model

AW264.7 cells was seeded in a petri dish. After the cells adhered, the supernatant was removed, washed

twice with PBS. Then, DMEN medium with lps concentration of 500 ng/ml was added and stimulated

for 12 h.

METHOD DETAILS

Material characterization

Thematerial morphology was observed using field-emission scanning electronmicroscopy (FE-SEM, sigma

500). The particle size was estimated by the dynamic light particle size analyzer (Zeta-sizer Nano ZS,

Malvern, UK). Powder X-ray diffraction (PXRD) patterns were recorded at a rate of 2�$min�1 in the range

of 5–40� (PXRD, D/max-2200/PC). The functional groups of the samples were further determined by Fourier

transform infrared spectra (FT-IR, Frontier, USA) in the wavenumber range of 4000�400 cm�1. The Ultravi-

olet-visible (UV-Vis) spectroscopy was measured on a Perkin Elmer LS55 UV-vis spectrometer. The structure

of TPA was measured by 1H NMR on Bruker (Swiss) AVANCE III (400 MHz). The scanning electron micro-

scope (SEM) image of hydrogel was acquired by field-emission SEM of Phenom PRO. The release process

of Zn2+ was detected by inductive coupled plasma atomic emission spectrometry (ICP-MS) (ICPAES,

Perkin-Elmer Optima 7000 DV).
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Calculation method of drug loading rate of berberine by UV-vis spectroscopy according to

the standard curve method

First, precisely weighed a certain mass of BR@Zn-BTB(M) and disintegrated it with a strong alkaline

solution. Then measure the ultraviolet absorption of berberine in the solution, and calculate

the mass (m) of berberine through the standard curve (see Figure S2). Loading rate of berberine =

m/M*100%.

Exploring the synthesis conditions of BR@Zn-BTB nanoparticles by orthogonal reaction

First, the effect of reaction time on particle size and loading rate of BR was explored. Weigh H3BTB

(60 mg) and ZnCl2 (22.74 mg), respectively, dissolve in 18 mL of DMF solution containing saturated con-

centration of berberine, dissolve by sonication, then mix and transfer the mixture to a hydrothermal tube

at 80�C, and reacted for 6 days. Take 3 mL every day, centrifuge at 10,000 rpm for 5 min, and wash with

methanol 3 times. Take an appropriate amount of precipitate, re-disperse it with DMF, and measured the

particle size with a particle size analyzer. The remainder was dried and weighed in the appropriate mass.

Soluble in strong alkaline solution, and then detected the absorbance of the solution with UV. Calculate

the loading rate of berberine. Then, the effects of reaction temperature, BR concentration, the ratio of

Zn2+ to H3BTB ligand and the input concentration of Zn2+ to H3BTB on particle size and berberine

loading rate were explored in turn. Finally, it was concluded that the reaction temperature was 80�C,
the BR concentration in the system was 1.5 mg/mL, the ratio of Zn2+ to H3BTB was 3, the input concen-

tration of H3BTB was 3 mg/mL, and the reaction time was 3 days, which were the best reaction

conditions.

Preparation of BR-loaded Zn-BTB (BR@Zn-BTB)

BR@Zn-BTB nanoparticles were prepared by a facile one-pot synthetic method. Typically, the aqueous so-

lution of berberine (3 mL, 3 mg/mL) was added into the clear DMF solution (3 mL) containing H3BTB (18 mg,

0.041 mmol) and ZnCl2 (6.82 mg, 0.123 mmol) and the mixture was stirred at 80�C for 3 days. The precip-

itated yellow product was obtained by centrifugation at 10000 rpm for 5 min, washed with methanol three

times and dried under vacuum overnight at 70�C.

Fabrication of the hydrogels incorporating BR@Zn-BTB

The aqueous solutions of ROS-responsive linker TPA and PVA with an initial concentration of 50 mg/mL for

both were prepared according to the previous repor.37 Pure hydrogel could be obtained by mixing the

above prepared PVA and TPA with equal volumes. Due to the viscosity of hydrogel, it is difficult to obtain

homogeneous composites by mixing the hydrogel and Zn-BTB or BR@ZnBTB particles. Thus, the homoge-

neous composites of Zn-BTB/Gel (denoted as B-Gel) or BZ-Gel (denoted as Z-Gel) were freshly prepared as

required for each experiment according to the following process. The BR@ZnBTB particles (10 mg) were

added to the PVA solution (10 mL, 50 mg/mL) under stirring for 6 h to give the concentration of 1 mg/mL

for BR@ZnBTB in PVA. Then, the solution of TPA (40 mL, 50 mg/mL) was added into the solution of the

prepared PVA (40 mL, 50mg/mL) which contained BR@Zn-BTB (1mg/mL) and stirred for 2min to give homo-

geneous hydrogel encapsulated BR@Zn-BTB composites of BZ-Gel (40 mL, 1 mg/mL). Here, the volume of

40 mL and the concentration of 1 mg/mL for BZ-Gel represents its initial reaction volume and concentration.

B-Gel and Z-Gel were prepared as the same procedure as BZ-Gel.

The BR and Zn2+ released from the BR@Zn-BTB nanoparticles and BZ-Gel scaffold in vitro

The dialysis bag was used to explore the release behavior of BR and Zn2+ in vitro. Four groups of BR@Zn-

BTB (3.97 mg, 4.78 mg, 4.98 mg, and 5.53 mg) was respectively dissolved in PBS (1 mL), which were then

placed in the activated dialysis bag. The four dialysis bags were immersed into 20 mL phosphate-buffered

solution (PBS, pH 6.5, 7.0, 7.4, and 8.0) at 37�C in a shaker with a speed of 100 r/min. At each defined time

point, 2 mL of the release medium was collected for the detection and replaced with an equal volume of

fresh PBS.

BZ-Gel (3 mL, 1 mg/mL) were placed in an activated dialysis bag and then placed in 20 mL PBS (pH 7.4) at

37�C in a shaker with a speed of 100 r/min to study the sustained release of BR and Zn2+. At each defined

time point, 2 mL of the releasedmediumwas collected for the detection and replacedwith an equal volume

of fresh PBS.
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Hydrogel degradation behavior for ROS scavenging in vitro

The pure hydrogel (1 mL) was added to 10mL PBS with or without H2O2 (100 mM) at room temperature. The

two samples were photographed to monitor the changes of the hydrogel at 0, 1, 1.5, and 2 h.

As the same process mentioned above, the pure hydrogel (1 mL) was added to 10 mL PBS with H2O2

(100 mM), then 0.5 mL solution was taken out at 0, 1, 1.5, and 2 h. Each solution was further incubated

with horseradish peroxidase (HRP, 50 mL, 5 mg/mL) and tetramethylbenzidine (TMB) (100 mL, 10 mg/mL)

for 5 min at 37�C in dark. UV-Vis was used to detect the characteristic absorption peaks at 650 nm at 0,

1, 1.5, and 2 h.

Antibacterial test

The inhibition zone method was used to test the antibacterial ability of the different nanoparticles. Three

types of bacteria of Escherichia coli, Staphylococcus epidermidis and Staphylococcus aureus were

activated twice, and the concentration for each of them was then adjusted to 5 3 107 CFU/mL. 200 mL of

bacterial suspension was cultured on Luria-Bertani (LB) medium and the Gel (100 mL), B-Gel (100 mL,

1 mg/mL), Z-Gel (100 mL, 1 mg/mL), and BZ-Gel (100 mL, 1 mg/mL) were introduced. Then LB medium

was placed on the bacteria incubator for 24 h. The antibacterial activity was investigated by measuring

the zone of inhibition (clear zone).

Cytotoxicity assay

To screen for the appropriate dosing concentration, the HaCaT cells and HSF cells (1 3 104 cells/well,

96-well plate) were incubated with different concentrations of BR, H3BTB, Zn-BTB, and BR@Zn-BTB for

24 h under 5% CO2 at 37�C to obtain the appropriate dosing concentration. Then the cell viability was

measured by CCK-8 assay (Bio-sharp, China).

After screening the appropriate dose concentration, the HaCaT and HSF cells were used to evaluate the

cytotoxicity of Zn-BTB and BR@Zn-BTB. HaCaT and HSF cells (1 3 104 cells/well) were seeded in 96-well

plates and incubated with Zn-BTB (40 mg/mL) and BR@Zn-BTB (40 mg/mL) particles for 1, 2 and 3 days,

respectively. The cells viability was then evaluated by CCK-8. The absorbance value of samples was

measured at 450 nm using an enzyme-linked immunosorbent assay (ELISA) plate reader (Molecular

Devices).

After verifying that 40 mg/mL is a safe concentration, hydrogel loading and live/dead staining were used to

further evaluate the biocompatibility of the composite system (BZ-Gel). HaCaT and HSF cells (53 104 cells/

well) were seeded in 24-well plates and incubated with PBS (40 mL), Gel (40 mL), Z-Gel (40 mL, 1 mg/mL) and

BZ-Gel (40 mL, 1 mg/mL) for 1, 2 and 3 days, respectively. The cell viability was measured through a live/

dead kit (Green fluorescence: Calcein-AM indicates live cells, Red fluorescence: Propidium Iodide (PI) in-

dicates dead cells) based on the manufacturer’s protocol and observed by fluorescence microscope

(IX53, Olympus, Japan).

Cell migration assay

The effect of BZ-Gel on the migration of HaCaT and HSF cells was evaluated in vitro using wound healing

migration experiments. Specifically, HaCaT (5 3 105 cells/well) and HSF (5 3 105 cells/well) were seeded in

24-well plates. After 24 h incubation, the cell scratch was created with a sterile pipette tip, washed with PBS,

and co-cultured with PBS (40 mL), Gel (40 mL), Z-Gel (40 mL, 1 mg/mL), and BZ-Gel (40 mL, 1 mg/mL) respec-

tively in high glucose cell culture medium (13.5 g/L) for 48 h. The cells were photographed with a

microscope.

Intracellular ROS scavenging evaluation

HSF (5 3 104 cells/well) was seeded in a 24-well plate and incubated with the following additives after 12 h:

1) 10 mL H2O2 (final concentration 100 mM); 2) 10 mL H2O2 and 40 mL Gel; 3) 10 mL H2O2 and Z-Gel (40 mL,

1 mg/mL); 4) 10 mL H2O2 and BZ-Gel (40 mL, 1 mg/mL). After 24 h of incubation, the cells were incubated

with DCFH-DA for 20 min. Then, after washing three times with PBS, DCF fluorescence (lex = 488 nm,

lem = 525 nm) was measured using a fluorescence microscope (IX53, Olympus, Japan).
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Quantitativereal-time polymerase chain reaction (qRT-PCR)

To verify the effect of BZ-Gel on the expression of MMP9 and TIMP1 under a high glucose environment

(13.5 g/L),45 HaCaT (1 3 106 cells/well) were seeded in a 6-well plate and cultured with BZ-Gel (40 mL,

1 mg/mL), Gel (40 mL) and Z-Gel (40 mL,1 mg/mL), and PBS as the control (40 mL) for 48 h.

To evaluate the anti-inflammatory effect of BZ-Gel, RAW264.7 cells (1 3 106 cells/well) were seeded in a

6-well plate. After stimulated with LPS (0.5 mg/mL) for 24 h, RAW264.7 cells cultured with Gel (40 mL),

Z-Gel (40 mL, 1 mg/mL), BZ-Gel (40 mL, 1 mg/mL) and PBS (40 mL) as the control for 48 h. Then detected

the expression of IL-6, IL-1bb and TNF-a.

The total RNA was obtained and extracted by using Trizol (Invitrogen, Waltham, MA, USA). cDNA was syn-

thesized from total RNA (1 mg) using 53 all-in-one RT Mastermix (ABM, Germany) at 37�C for 10 min, 65�C
for 15 min, and at 95�C for 3 min. qRT-PCR was conducted using TB Green� Premix Ex Taq� II (Takara,

Japan). The sequence of MMP9 and TIMP1 used for qRT-PCR reactions were shown in Table S1. The

sequence of IL-6, IL-1bb and TNF-a used for qRT-PCR reactions were shown in Table S2. All primers

were found in the Primer Bank and synthesized by Genewiz (Shanghai), the specificity of the primers was

confirmed before being used.

Wound healing assessment

The experimental animals in this study were purchased from the Guangdong Provincial Animal Center, and

the animal experiments were approved by the Guangdong Provincial Animal Ethics Committee. The dia-

betic mice were induced by streptozotocin (STZ) according to previous reports previous reports.55 Briefly,

to induce diabetic Mellitus-like symptoms, 6�8 weeks C57BL/6 mice were injected intraperitoneally with

STZ (50 mg/kg body weight per day) until the blood glucose levels were continuously higher than

300 mg/dL (16.7 mM). The blood glucose levels were measured by using glucose meters (Accu-Chek

Performa). The induced diabetic mice were randomized into the control, Gel, Z-Gel, and BZ-Gel groups ac-

cording to their blood glucose levels and anesthetized with tribromoethanol (1.25%). After the mice were

anesthetized, a standardized full-thickness wound with a diameter of 10 mm on the dorsum of each mouse

was created. After 3 hours of exposure to UV light, the Gel (150 mL), Z-Gel (150 mL, 1 mg/mL), and BZ-Gel

(150 mL, 1 mg/mL) were applied to the wound beds and covered with gauze. The images of the wounds

were photographed on days 0, 5, 9, 12 and the size of the wound was measured. The formula for calculating

the size of diabetic wounds is as follows:

The percentage of wound size reduction (%) = (Day0 � Dayx)/Day0 3 100%:

where the initial area of the wound is marked as Day0 and Dayx is the area of the wound on day x (x R 1) is

marked as dayx. The mice were sacrificed at day 9 and day 12 after surgery.

Histological staining of wound tissue in diabetic mice

To characterize the skin re-epithelialization of diabetic mice, histological staining of wound tissue sections

was used. After the mice were sacrificed on Day9 and Day12, 4% paraformaldehyde was used to fix the skin

tissues in the wound bed for 24 h. Then, paraffin-embedded tissues were sectioned into 4 mm thickness sli-

ces, and hematoxylin and eosin (H&E) staining and Masson’s trichrome staining were performed.

Image J counts inflammatory cells

Open the picture you want to edit.

Grayscale transformation: Select Image->Type->8-bit in the menu bar to convert the image to be

processed into an 8-bit grayscale image;

Grayscale threshold setting: Select Image->Adjust->Threshold in themenu bar; according to the grayscale

value configuration of the picture, extract the threshold value of the maximum and minimum

grayscale values in the picture, drag the grayscale selection bar, and select the appropriate grayscale value

range;

ll
OPEN ACCESS

iScience 26, 106775, June 16, 2023 21

iScience
Article



Manual denoising: First, select a drawing tool according to the shape of the part to be processed in the

picture, taking an arbitrary curve as an example; use the cropping tool to crop the part that needs to be

processed in the picture;

Scale bar setting: To use this graph as a picture for cell counting, you need to first perform a scale bar

setting. The settings are arranged as follows; select the line drawing tool to draw a straight line on the

graph;

Counting: After setting the scale, you can count the cells. Select Analyze->Analyze Particles.

Image J quantify Masson staining

Step 1: In ImageJ software, choose File -> Open to open a Masson staining image to be analyzed.

Step 2: Select image/type/RGB stack.

Step 3: Select image/adjust/threshold.

Step 4: Adjust the threshold so that collagen is selected (red means selected).

Step 5: Select analyze/measure.

Step 6: Area represents the pixels occupied by the red area, and %Area represents the proportion of the

red area in the entire image.

qRT-PCR of the wound tissue

The total RNA of re-epithelized skin tissue was extracted by Trizol (Invitrogen, Waltham, MA, USA). The

isolated RNA (1 mg) was then reversely transcribed into cDNA using 53 all-in-one RTMastermix (ABM, Ger-

many) at 37�C for 10 min, 65�C for 15 min, and at 95�C for 3 min. qRT-PCR was conducted using TB Green�
Premix Ex Taq� II (Takara, Japan). GAPDH was used as the reference gene and the primer sequences

detected in this study were shown in Table S2.

QUANTIFICATION AND STATISTICAL ANALYSIS

Randomization was used to assign the various samples to the experimental groups and treatment condi-

tions for all in vivo studies. All quantitative results were expressed as mean G Standard Error of Mean (SEM).

The data was analyzed using Unpaired Student’s t test or one-or two-way ANOVA onGraphPad Prism 8.0. A

value of p < 0.05 was considered to be statistically significant.

ll
OPEN ACCESS

22 iScience 26, 106775, June 16, 2023

iScience
Article


	ISCI106775_proof_v26i6.pdf
	Hydrogel with ROS scavenging effect encapsulates BR@Zn-BTB nanoparticles for accelerating diabetic mice wound healing via m ...
	Introduction
	Results and discussion
	Preparation and characterization of BR@Zn-BTB particles and BZ-Gel hydrogel scaffold
	Cumulative release of BR and Zn2+ in BR@Zn-BTB and BZ-Gel hydrogel scaffold
	In vitro antibacterial activity of BZ-Gel hydrogel scaffold
	The pro-proliferative and pro-migratory effects of BZ-Gel hydrogel scaffold
	In vitro antioxidant and anti-inflammatory effects, and the influence on MMP-9 gene expression of BZ-Gel hydrogel scaffold
	The BZ-Gel hydrogel scaffold accelerating diabetic wound healing in vivo
	The effect of BZ-Gel hydrogel scaffold suppressing inflammatory factors in diabetic wound
	The effect of BZ-Gel hydrogel scaffold on promoting collagen deposition and inhibiting the expression of MMP-9
	Conclusions

	Supplemental information
	Acknowledgments
	Author contributions
	Declaration of interests
	Inclusion and diversity
	References
	STAR★Methods
	Key resources table
	Resource availability
	Lead contact
	Materials availability
	Data and code availability

	Experimental model and subject details
	Diabetic mice model
	Cell line culture
	High-glucose environmental cell model
	Inflammatory cell model

	Method details
	Material characterization
	Calculation method of drug loading rate of berberine by UV-vis spectroscopy according to the standard curve method
	Exploring the synthesis conditions of BR@Zn-BTB nanoparticles by orthogonal reaction
	Preparation of BR-loaded Zn-BTB (BR@Zn-BTB)
	Fabrication of the hydrogels incorporating BR@Zn-BTB
	The BR and Zn2+ released from the BR@Zn-BTB nanoparticles and BZ-Gel scaffold in vitro
	Hydrogel degradation behavior for ROS scavenging in vitro
	Antibacterial test
	Cytotoxicity assay
	Cell migration assay
	Intracellular ROS scavenging evaluation
	Quantitativereal-time polymerase chain reaction (qRT-PCR)
	Wound healing assessment
	Histological staining of wound tissue in diabetic mice
	Image J counts inflammatory cells
	Image J quantify Masson staining
	qRT-PCR of the wound tissue

	Quantification and statistical analysis




